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Get ready for a
Hands On exercise
when you see the
Keyboard icon
above.

Look for tips in
the left margin of
this guide. The
arrow icon presents
useful information
or a warning.

Getting Started

It helps to have a slide design in mind before you
begin. Sketch a sample slide on a sheet of paper
and consider what colors/designs (if any) you
would like to use.

hether creating desktop publications, designing lengthy
tables or crunching numbers in a simple spreadsheet,
planning is the key. The same is true before you present your
research and yourself (!) to an audience. How much do you
expect from PowerPoint? Even a simple slide show requires text layout,
skillful use of color and fade in/out between slides, otherwise known as
transition, to effectively convince your critics. Observe other presenters
and write down presentation effects/features that you might consider
using in your own presentation. Chances are if you've seen it done
before, you can recreate the same effects in PowerPoint. However, keep
in mind the tips/warnings as described in the left margin - use
PowerPoint as a medium and let the content dazzle your audience!

Our topic is PowerPoint "98, the most recent release from Microsoft that
allows anyone to easily design and create professional, quality
presentation slides. Slides may be printed onto transparencies for
overhead use or saved and reopened on another system for on-screen
viewing. This is not a comprehensive guide to PowerPoint ‘98, but we’'ll
cover areas that allow you to:

e Createslides

e Professionally format your slides

e Import images, tables and charts

¢ Present your slides with “pizzazz”
This guide is designed so that you may work through the entire booklet
in one reasonable sitting. If you have weeks or months to go before

creating your presentation, you may refer to the Index, near the back of
the guide, to help you relocate specific features and exercises. Let’s start!
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The PowerPoint 98 Window/Toolbars

The PowerPoint presentation window is where you will spend most of
your time creating, formatting and arranging slides. A blank, unnamed

Open the sample  {\;ncaved) slide is shown below:

PowerPoint Demo
file your instructor o M
has provided. I
Rename using your
first name and save
onto a floppy disk.
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View buttons near the bottom left of the window (or from the View
menu) enable you to switch among different views, including:

B e Slide view - one slide displayed; WYSIWYG (What You See Is What
You Get) representation
=| ¢ Outline view - enables you to see the title and body text of all your

slides simultaneously; allows you to move headings and other
information by clicking and dragging




Rest your mouse
arrow on any
toolbar button for a
reminder of what
function it serves.

POWERPOINT '98

¢ Slide Sorter view - view all the slides in a presentation to quickly see
layout and sequence

¢ Notes Pages view - enter or view any notes associated with the slide

e Slide Show view - run your complete slide show

Three toolbars appear on the default presentation window when you
open PowerPoint. They include the Standard Toolbar, the Formatting
Toolbar and the Drawing Toolbar. You might recognize some of the
toolbar buttons from those in MS Word or MS Excel. Most of these
commands are available from the Menu Bar as well. Go to the View
Menu to see other available toolbars.

DwEev|: =8 2w
Fig. 1B: Standard Toolbar
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Fig1C: Formatting Toolbar

Take a couple of minutes to point at various toolbar buttons and see
what functions they serve. Try out the Drawing toolbar buttons on the
sample PowerPoint document provided by the instructor (make sure
you perform a File / Save As and rename the file on the floppy so you
don't edit the original file; you might need the original later). This is
your time to experiment! Add arrows to point out research findings.
Highlight data by drawing a shadow box around your information.
Experiment freely and don’t forget to click the Undo toolbar button
when needed.

Template vs. Blank Presentation

The choice is yours as to whether you want to use a slide template
designed by Microsoft or create one of your own. Consider these
pros/cons:
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e Microsoft slide templates offer background colors/designs, text
placement, font type/size, and format features in over 150 different
configurations. You customize the text and slides are ready within
minutes (or longer, depending on how fast you type!). You still can
format text and background color and make other adjustments. *A
time-saver.

» If time restraint is not an issue, consider building your own slide
from a blank presentation. You might customize the background to
reflect an element or critical point in your presentation. Many
students prefer easy-on-the-eye white backgrounds for slides with
detailed graphs and images. This way the slide design doesn’t
compete with the content. You can vary the slide design within a

"Busy" slides presentation, just try to be as consistent as possible.

(those with colorful

charts or images) + Consider using the Auto Content Wizard. A string of questions
might look best to gather information and create a sample slide series which you can
wsit‘gg"‘;‘?&jm a edit to your satisfaction. Although none of the Wizards relate
background. directly to scientific research, be prepared for a quick, easy input

session resulting in lots of presentation tips! A benefit to those who
have never given a presentation or created slides from scratch.



Outline view
displays a small
Color box that
previews each slide
as you work on it.

DESIGN CUSTOMIZATION

Working with Slides

The first important rule in working with slides is to limit the amount of
information on each slide. This doesn’t mean you have to delete
information; instead use more slides. A general rule is 3-5 points on
each slide, with an introductory heading. A heading introduces the next
stage of your presentation (and the 3-5 points that follow). Slides that
contain images, graphs or data tables should have either a heading or
caption and sometimes both.

Choose New under the File menu. Choose the blank presentation at the
New Slide window and click OK.

Click on the Outline View symbol (bottom left of presentation window).
You’'ll see a mini slide and your cursor should be ready for text (it
blinks). Make up a heading for your first slide. For example, type:
Upcoming Birthdays or Courses for Next Semester. If you make a
mistake use your keyboard/mouse to move/highlight and edit.
PowerPoint allows you to edit documents similarily to most word
processors like Microsoft Word.

When you hit the Return key, a new numbered slide will appear. What
if you weren’t ready for the new slide and only wanted to type the next
level of information? Click the green arrow to the left of your mini slide
and a bullet is formed in place of the second slide. Type in several
bullets of information and make up a few new slides. Notice that you
can rearrange bullets, indents and even slide order using the arrows in
Outline View.

If you prefer to see each slide individually, switch to Slide View. You
can add and edit text from this view as well. Use Slide View to do most
of your work with slides; we’ll concentrate on this view throughout this
guide. Slide View shows a WYSIWYG (what you see is what you get)
version of each slide. Move between the slides by using the Page
Up/Down keys on your keyboard or the scroll bars on the presentation
window. Now for the common actions:

Deleting Slides

Delete slides in any view except Slide Show. Navigate to the slide and
choose Edit menu - Delete Slide. Use the Undo button (illustration
shown on page 3) if you delete a slide by mistake.
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Copying and Moving Slides

You'll want to specify the Slide Sorter View (see icon at left) for these
functions. Select a slide (or multiple slides by holding down the shift
key while you make your selections) and Edit - Copy. Anchor your
cursor at the new location and choose Edit - Paste. Move slides by
selecting and dragging them to the new location. A vertical line shows
you where your slide will appear when you release the mouse.

Change the Slide Layout

Change the slide layout in the Slide Sorter View as well. Highlight the
slide by clicking on it. Choose Format menu - Slide Layout. In the Slide
Layout dialog box, choose the new layout and click Apply.

Note =

Menu commands differ between views. Use the Slide view to work on
textual/image slide content and Slide Sorter view to add your transitions and
change slide order. Slide Master (see next section) is a lifesaver if you change your
mind re: universal format features like font style or background design.

Slide Master

Slide masters are master documents that control the appearance and
layout of the slides you create. If you edit the slide master, all slides will
reflect this change. For example if you decide at a later date to add an
image in the bottom corner of your slides, you may make the addition
once to the slide master, avoiding the image placement multiple times.

Use the Slide Master to include borders, page numbers, navigation
buttons or hot buttons (link to a web URL). Remember that all slides
will reflect your changes.

Open the PowerPt Demo document provided by your instructor (if not
already open) and choose View - Master - Slide Master. The Slide
Master appears. Note how this slide selection has title, body, and footer
areas.

Click in the title area and change the font style and color, using the
toolbar buttons and drop down menus. Be creative, but realistic! You
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don't want to choose type that is hard to read or mix too many font
colors or types within one presentation.

Scroll through the slides to view your changes.

Notes



Subscript and
Superscript formats
are both available
from the Font area
under the Format
menu,
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Formatting and Transitions

Formatting includes font style, size, color, effect, and shape (Word Art).
The formatting toolbar offers quick access to most of these options and
you now know how to highlight and change entire areas of your
presentation using the Slide Master.

Font effects include Shadow and Emboss. The Shadow button is shown
at the left and appears next to the Bold, Italic and Underline buttons on
the formatting toolbar. Highlight text and click once on the Shadow
button to activate and once again to disable.

The Emboss feature is found on the Format menu under the Font area.
Select text before activating the Emboss feature.

Word Art is located on the Drawing toolbar. We won't detail Word Art
in this guide, but if you need special text effects, use On-Line Help to
learn more about this feature.

Transitions are special effects that occur from one slide to another.
PowerPoint uses symbols in the Slide Sorter view to show that
transitions are applied to slides. You may view transitions while
applying them or by running a Slide Show. Slide sorter also allows you
to view transitions. Click once on the transition icon under each slide.
We won't go into the advanced features of applying slide transitions,
but you can specify sounds to accompany your transition and advance
slides automatically as well as on a mouse click.

For this exercise we'll change some of the transistions that exist on our
demo presentation. This will give you a chance to view some of the
many transition effects. See Note below after this exercise.

Go to Slide Sorter view and click on a slide (try Slide #1). Click on the
Slide Transitions button (shown at left) to activate the corresponding
dialog box.

Choose the effect you want from the pop-up menu in the Effect area.
You may also choose the speed in which the transition will operate. For
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this exercise, specify the transition to advance on a mouse click. Watch
the picture in the box for an example of the effect. Try several effects
until you find one you like. Apply the effect to all of your slides.

Run the Slide Show, clicking with your mouse to advance the slides.

Note

Don’t go overboard with formatting features and special effects in your
presentation. Stick to one transition effect (if any) and use no more than two font
styles and colors. Use font size, "white" space or simple effects (i.e. Bold type) for
variety ot intensity. A consistent slide show is more professional and credible.

Inserting Images

Many students ask that images, gels, photographs or clipart be
incorporated into their presentations. With the availability of
departmental or personal scanners, the opportunity to show visual
proof of research findings is persuasive and impressive.

Your PowerPoint document may already contain an image in the form
of a background design. Keep your slide background simple so that it
doesn't interfere with slide content. If necessary use a monochrome slide
when showing images; it's acceptable to have a monochrome slide in the
middle of your presentation, especially if it helps your audience view
the information more easily.

The Insert menu is a popular location in that we insert graphs, tables,
worksheets, clipart and scanned images from this area. Click on the
Insert menu and choose Picture... Clipart. For this exercise, we'll
assume that one of the 75 plus clipart images relates to our slide content.

Scroll through the database and click on one of the images. Choose
Insert to place the image onto the selected slide.

Open Insert / Picture / Clipart again to see features available from this
dialog box. You may search for clipart that falls under specific
keywords, add separate clipart images to this database or import clipart
from other applications on your Mac.
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Inserting Word Tables

Microsoft Word tables can be inserted into PowerPoint slides. Start by
choosing Slide View. Next place your cursor where you want the table
to appear.

Choose Insert / Picture / Microsoft Word Table to bring up the Insert
Word Table dialog box.

Enter the number of columns and rows you want for the table and click
on OK. A Word table is then placed on the slide.

Enter text in the table. For example make up a weekly schedule for
yourself (i.e. Monday at 8:00am-9:00am = Biology 235; Tuesday at
8:00am-9:00am = Meet with advisor, etc.). When done click anywhere
outside the table to deactivate it.

If you need to correct information or add columns/rows, double-click
on the table and the Word application will activate, allowing you to edit
the information from the original application. The Insert command
supports the object embedding and linking feature (OLE). The table will
"correct itself” in PowerPoint due to the link established between the -
applications.

What if you have an existing table in Word and would like to add it to
your presentation? In this case use the Edit / Copy and Edit / Paste
sequence to place the table into your PowerPoint slide. The difference
between the OLE and Copy/Paste features is that a table pasted into
PowerPoint is static. If you want to make any changes to the table, you
must open Word, edit the table and then copy and paste it a second time
into your presentation.

Inserting Excel Charts

Inserting Excel charts/data works similarly to inserting Word tables.
You may select individual cells, a range of cells or a graph (aka chart),
copy and paste them into your slide.

Another option is available only if you have Microsoft Graph installed
on your system. With this feature, you click on the Chart option under
the Insert menu. Microsoft Graph loads a spreadsheet where you enter
data in a simlar fashion to that of MS Excel. A chart is automatically

10
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generated based on this data and inserted into the selected PowerPoint
slide.

Notes
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Printing Presentations

You may want to print a set of your slides on overhead transparencies
in case of computer/technical difficulties. The Service Bureau has a
color copier available (approx. 80 cents per copy) if needed.
Transparencies also give you the option of viewing your presentation
when only an overhead is available.

Choose File - Page Setup to reveal the many different sizes you may
specify for the slides. You'll be most interested in printing the following
sizes:

e Letter Paper - Width=10 inches; Height=7.5 inches; Landscape
orientation. Choose when you want to print on paper and fill the
entire page.

e 35mm Slides - Width=11.25 inches; Height=7.5 inches;Landscape
orientation. Ideal for reduction to 35 mm slides.

* Overhead - Use this option when creating transparencies.

Choose the page orientation if necessary - portrait or landscape (most
slides are landscape orientation). Note that you can specify different
orientations for your speaker's notes, handouts and outlines.

If you want to print only specific slides in your document, first Hide the
slides you don't want to print by choosing Slide Show - Hide Slide for
each unwanted slide and then choose File - Print. The Print Hidden
Slides check box becomes available. Leave the box empty to exclude the
hidden slides. Check the box to print hidden slides.

PowerPoint Viewer

PowerPoint Viewer provides the software needed to load and view any
presentation created in PowerPoint. PowerPoint Viewer is installed on
the computer system in Biology classroom 2021 in the Robert N. Noyce
'49 Science Center. You can either load PowerPoint Viewer from a disk

12
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(copy from your Microsoft Office folder, if available) or download the
Viewer from Microsoft's web site at http://www.microsoft.com .

You may also send your presentation to another person via e-mail using
the attachments feature. Each party will need an e-mail client program -
for example, Outlook Express, Eudora or Claris Emailer - installed and
mail preferences set within the application.

Polished Presentations
Consider these tips to give your presentation polish:

Test your presentation on the hardware you plan to use BEFORE the
audience starts taking their seats. Check the room schedule for
available openings or stop by the Science Division Office to reserve
the room for a practice session.

Try not to spend too much time on a single slide. Five minutes is too
long to expect your audience to spend staring at the same slide.
Break up chunks of information to ensure that audience members
don't fall asleep!

Use the mouse pointer as an onscreen pointer; skip the wooden
sticks.

Add a blank slide (or one with an attractive background) as the last
slide in your presentation. Viewing a simple background is more
visually appealing and professional than getting dumped back into
slide view.

If you put main points or images on your slides, you'll be less likely
to revise or create new slides mere days (or minutes!) before your
scheduled presentation. Use slides to emphasize and/or summarize
methods and findings.

Audience members are more likely to jot down written information .
gathered from your slides than from your speech. Use this to your
advantage by giving the audience a minute to absorb each new slide
before you begin talking.

Use the Speaker Notes feature to create a companion notes page for
each slide. Select a slide then choose Notes Pages under the View -
menu. Enter your notes and use the Zoom control to enlarge the text
if needed. Print to use the notes during your presentation.

13
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Closing

You are now ready to create a presentation basedon your own material.
There are more advanced topics in PowerPoint '98 that we did not cover
in this booklet, but the concepts you learned in this guide will assist in
preparing an eye-catching technical enhancement to your research.
Good luck!

A PowerPoint Demo file to help you practice concepts in this booklet is
available. The demo contains three formatted slides and a practice slide.
Please see Vicki for more information.

The Index provided at the end of this guide will help you locate features
and commands. If you would like further assistance or information
regarding more advanced topics, you may contact Vicki on the Grinnell
College campus at ext. 3044 (641-269-3044) or by e-mail at
wadev@grinnell.edu. She is located in the Robert N. Noyce '49 Science
Center (Science Division Office 1232).

Notes



Graphic File Types

You can insert many popular graphics file formats into your presentation, either
directly or with the use of separate graphics filters. You don't need a separate
filter to insert the following file formats:

Joint Photographic Experts Group (JPEG)
Macintosh Picture (PICT)

Macintosh Paint (PNTG)

Portable Network Graphic (PNG)
Windows Bitmap (BMP)

However, all other file formats in the list that follows do require a separate filter.
If you didn't install the filters when you installed PowerPoint, you can rerun the
Office Installer and add the filters.

Encapsulated PostScript (EPS)

Graphics Interchange Format (GIF)

JPEG File Interchange Format (JPEG)

Macintosh Picture (PICT)

Macintosh Paint (PNTG)

Portable Network Graphics (PNG)

Tagged Image File Format (TIFF)

Windows Bitmap (BMP)

Windows Metafile (WMP) and Enhanced Windows Metafile (EMF)
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